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Introduction

What Is in This Document

This document describes how to back up and restore Series 7 applications in Windows and UNIX 
environments.

What You Need to Know to Use This Document Effectively

You must be an administrator of IBM Cognos products and must have administrative privileges to 
the computers where the applications are installed.  

Other Information

The following documents contain related information, and may be referred to in this document.

For more information about using this product, and about education and training, visit the IBM 
Cognos Resource Center.

This document is available as online help and an online book.

Our documentation includes user guides, tutorial guides, reference books, and other materials to 
meet the needs of our varied audience. 

Online Help
All information is available in online help. Online help is available from the help button in a Web 
browser, or the Help menu and help button in Windows products. You can also download the 
online help from the IBM Cognos Resource Center.

Topic Location

How to install an IBM Cognos Series 7 
product

Installation Guide 

printed book, and online book (PDF)

How to upgrade from a previous IBM 
Cognos release

Installation Guide 

online book (PDF)

How to test the installation Installation Testing and Samples Setup Guide 

online book (PDF)

How to troubleshoot the installation Installation Testing and Samples Setup Guide 

online book (PDF)

How to configure components, make 
adjustments to configuration settings

Configuration Manager User Guide 

online book (PDF), and Windows help

Deploying IBM Cognos solutions Deployment Manager User Guide 

online book (PDF)
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Introduction  
Books for Printing
The information in each online help system is available in online book format (PDF). However, 
the information from a given help system may be divided into more than one online book. Use 
online books when you want to print a document or when you want to search the whole 
document. 

You can print selected pages, a section, or the whole book. You are granted a non-exclusive, 
non-transferable license to use, copy, and reproduce the copyright materials, in printed or 
electronic format, solely for the purpose of providing internal training on, operating, and 
maintaining the IBM Cognos software. 

You can also read the product readme files and the installation guides directly from IBM Cognos 
product CDs.
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Back Up and Restore Series 7 Applications

This document describes how to back up and restore Series 7 applications in Windows and UNIX 
environments.

Assumptions
The procedures provided here assume the following:
• That for multiple-server installations, you must repeat some of the steps on each server.
• You installed IBM Cognos Series 7 products in the default location, C:\Program 

Files\Cognos\cern in Windows, and /usr/cognos/cern in UNIX,
where n is the rendition number of the version you installed, such as cer4 or cer5.

• You will not change the directory locations when you restore IBM Cognos products. 
If you plan to move the application, use these procedures to back up the application, and then 
use IBM Cognos Deployment Manager to move the application.

• You are using Bourne shell commands for UNIX.
• You have administrative privileges to perform backup and restore procedures.
• You will create a backup directory before you start the backup procedure.

Backing Up and Restoring in Windows
Backing up and restoring is the process of saving IBM Cognos configuration files and data files to 
one location so that you can incorporate them into your backup strategy.

Some IBM Cognos products and components have services that must be stopped before you begin 
the backup process. These services must be started when you complete the restore process.

Tip: You can use Configuration Manager to stop and start your product and component services. 
You can also stop and start services using the Control Panel.

Back Up and Restore Configuration Settings in Windows
If you changed the property values of your IBM Cognos products or components, you must save 
the customized configurations as a Configuration Specification file (.ccs) if you want to reuse 
them. You can then reapply the configuration file when needed.

Use Configuration Manager to back up and restore Series 7 configurations.

Steps to Back Up
1. Start Configuration Manager.
2. Click Open the current configuration. 
3. From the File menu, click Save As. 
4. In the File name box, type a name for the Configuration Specification file (.ccs).
5. In the Save in box, select the location to save your file, and click Save. 

Steps to Restore
1. Start Configuration Manager.
2. From the File menu, click Open a configuration from a file 
3. Browse for the file, and click Open. 

Confirm that the configuration settings are correct.
4. In the Explorer pane, click the computer name.
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Back Up and Restore Series 7 Applications  
5. From the Actions menu, click Apply Selection. 
A message states that this action will apply configurations to the computer you are working 
on.

6. Click Yes. 
7. From the Actions menu, click Start Service. 

A message states that this action will start components to the computer you are working on.
8. Click Yes. 

The services are registered and started.

Back Up and Restore Access Manager Information in Windows
Access Manager provides a centralized environment to define, store, and maintain security 
information for IBM Cognos business information applications.

You store authentication data in one of the following sources:
• a namespace on an LDAP directory server
• a local authentication export file (.lae)

If you want to maintain your security information, you must back up and restore the 
authentication information by exporting it. You can use Access Manager-Administration to back 
up and restore Series 7 security.

Alternatively, you can back up your entire directory server database. For more information, see 
"Back Up and Restore the Directory Server Data on Windows".

Steps to Back Up
1. Start Access Manager - Administration.
2. In the Authentication Information pane, click the namespace that you want to back up.
3. From the Action menu, click Log On, and type your logon information.
4. Click the namespace.
5. From the Action menu, click Export to .LAE File. 
6. Click Add. 
7. Type a Logical name and enter a File name for the local authentication export file (.lae), then 

click OK. 
8. Click Empty the target namespace. 
9. Click Export. 

Steps to Restore
1. Start Access Manager - Administration.
2. In the Authentication Information pane, click the namespace that you want to restore.
3. From the Action menu, click Log On, and type your logon information.
4. Click the namespace.
5. From the Action menu, click Import from .LAE File. 
6. Click the correct local authentication export file (.lae), and then click the namespace.
7. Click Empty the target namespace. 
8. Click Import. 

Back Up and Restore the Directory Server Data in Windows
If you are using a directory server to store Access Manager security information, you can back up 
and restore the entire directory server database using an LDAP Data Interchange Format (.ldif) 
file. The .ldif file contains information about the directory server database, as well as information 
specific to Access Manager, such as namespaces.

The following information indicates how to backup the data for a SunONE directory server.
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Back Up and Restore Series 7 Applications
Use the directory server console to import and export the directory server data into an .ldif file, 
then use the .ldif to restore the information into a directory server.

For more information, see the Sun Web site or your third-party documentation. 

Steps to Backup 
1. Open your directory server console and log on.

For a list of supported versions, see your directory server documentation.
2. In the Console window, expand the server host, and the Server Group folder, and then 

double-click on the directory server used by your IBM Cognos Series 7 products.
3. Click the Configuration tab.
4. From the Console menu, click Export.  
5. In the Export Database dialog, specify a secure location and filename for the .ldif, then click 

OK.  

Steps to Restore
1. Open your directory server console and log on.
2. In the Servers and Applications window, expand the server host, and the Server Group folder, 

then double-click on the new directory server to be used by your IBM Cognos Series 7 
products.

3. Click the Configuration tab.
4. From the Console menu, click Initialize Databases.  
5. Enter the name of the .ldif you created earlier. 
6. In the Initialize Database column, ensure the check box is selected, and then click OK 

A message appears, warning that the operation will overwrite certain information and certain 
conditions may affect the success of the initialization. 

7. Click Yes. 

Back Up and Restore Upfront in Windows
Upfront is the customizable user interface that you use to view, find, organize and share IBM 
Cognos reports and queries on the Web. You back up and restore the Upfront data store to 
preserve all the information about the resources that Upfront manages, in case any of the 
information is lost or corrupted. 

To either backup or restore the data store, you must run the upfdbadm.exe utility on the computer 
where the data store is installed.

IBM Cognos does not support a "hot" restore of the Upfront data store. This means that before 
you restore the data store, you must stop the Upfront dispatcher. If a hot restore of the Upfront 
data store is performed, errors may occur.

When you back up Upfront, you must back up your security information, and the data stores for 
the IBM Cognos products referenced by NewsItems in this NewsIndex. For more information, see 
"Back Up and Restore Access Manager Information in Windows".

If you change your administrator password and restore the data store at a later time, the data 
store password and the administrator password will not be synchronized. When you start Upfront 
after restoring the data store, Upfront displays an error message indicating that Upfront could not 
log in to the database server. To resolve this problem, change the data store password. For 
information, see the section on administering the data store in the Upfront Server Administration 
Guide. 

In the following steps, specific version numbers for a release are substituted for an italicized letter 
n (n). For example, the cern folder substitutes the rendition number of your IBM Cognos files. The 
rendition number depends on the version you installed, such as cer4 or cer5.

Steps to Back Up
1. Start Upfront.

Ensure that the data store is started.
Backup and Recovery Guide (Asian Edition)  9
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2. Open the Command Prompt window.
3. Run upfdbadm.exe with the -b parameter, and type the location and name of the backup file. 

For example, type the following:
c:\Program Files\Cognos\cern\bin\upfdbadm.exe -b c:\backup\UpfrontStore.bak

4. Close the Command Prompt window.

Steps to Restore
When you restore the Upfront data store you must also restore your security information and the 
data store for all the IBM Cognos products referenced by NewsItems in this NewsIndex.
1. Start Upfront.

Ensure that the data store is started.
2. Open the Command Prompt window.
3. Run upfdbadm.exe with the -r parameter, and type the location and name of the backup file. 

This will restart the Upfront server and disconnect all active users. 
For example, type the following:
c:\Program Files\Cognos\cern\bin\upfdbadm.exe -r c:\backup\UpfrontStore.bak

4. Close the Command Prompt window.

Back Up and Restore PowerPlay Enterprise Server Metadata in Windows
When using PowerPlay Enterprise Server, you create a set of directories and files that represent 
your PowerPlay Enterprise Server metadata. To protect your PowerPlay Enterprise Server 
metadata from corruption, you may want to keep backup copies of this information.

If you use Access Manager and Upfront as part of PowerPlay Enterprise Server, you must also 
back up their metadata. For more information about these topics, see "Back Up and Restore 
Access Manager Information in Windows", or "Back Up and Restore Upfront in Windows".

In the following steps specific version numbers for a release are substituted for an italicized letter n 
(n). For example, the cern folder substitutes the rendition number of your IBM Cognos files. The 
rendition number depends on the version you installed, such as cer4 or cer5.

Steps to Back Up
1. Stop the services for PowerPlay Enterprise Server (cern), on all of the computers in the server 

group.
2. Open Windows Explorer.
3. Go to the Cognos\cern\ppserver directory.
4. Copy the PPSRoot.cfx file to the backup location.
5. Copy the PPSRoot directory, its contents, and all subfolders, to the backup location. 

If you are using the Mount At property to store or share metadata across multiple servers, you 
must locate that data using the PowerPlay Server Administration tool and copy it to the 
backup location.

6. Copy any required cubes (.mdc), or report files (.ppx) to the backup location.
Tip: To locate your cube files or your report files, use the PowerPlay Server Administration 
tool and check the Cube Source property.

7. If you use audit information, copy audit files to a backup location.
Audit files are named ppes_audit.log and are located in ppserver directory. For more 
information about audit files, see the PowerPlay Enterprise Server Guide.

Steps to Restore
1. Stop the services for PowerPlay Enterprise Server (cern), on all of the computers in the server 

group.
2. Go to the Cognos\cern\ppserver directory.
3. Delete the PPSRoot.cfx file.
4. Delete the PPSRoot directory, its contents, and all subfolders.
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5. Copy the PPSRoot.cfx backup file to Cognos\cern\ppserver.
6. Copy the backed-up PPSRoot directory, its contents and all subfolders, to 

Cognos\cern\ppserver.
7. Copy the backed-up cubes (.mdc) and reports (.ppx) to the correct folder location.
8. Copy the Mount At directories to the original folder location.
9. Copy audit files to the ppserver directory.
10. Start the services for PowerPlay Enterprise Server (cern), on all of the computers in the server 

group.

Back Up and Restore IBM Cognos NoticeCast in Windows
The IBM Cognos NoticeCast data store resides in a third-party DB2, Informix, Oracle, or SQL 
server database. Use your database administration tools to back up and restore the IBM Cognos 
NoticeCast data store. When you back up IBM Cognos NoticeCast, you must also back up 
Upfront and Access Manager. For more information about these topics, see "Back Up and Restore 
Access Manager Information in Windows", or "Back Up and Restore Upfront in Windows".

Backing Up and Restoring in UNIX
Backing up and restoring is the process of saving IBM Cognos configuration files and data files to 
one location so that you can incorporate them into your backup strategy.

The UNIX commands used in this document are for Bourne shell.

Back Up and Restore Configuration Settings in UNIX
If you changed the property values of your IBM Cognos products or components, you must save 
the customized configurations as a file if you want to reuse them. You can then reapply the 
configuration file when needed.

Use Configuration Manager to back up and restore Series 7 configurations.

In the following steps specific version numbers for a release are substituted for an italicized letter n 
(n). For example, the cern folder substitutes the rendition number of your IBM Cognos files. The 
rendition number depends on the version you installed, such as cer4 or cer5.

Steps to Back Up
1. Go to /usr/cognos/cern/bin
2. Type configure. 
3. Type opencurrent. 

A configuration specification file (.ccs) is created based on the computer you are working on.
4. Type the following, where location/filename.ccs is a directory and file name to which you 

have write access:
save location/filename.ccs 

5. Type exit. 

Steps to Restore
1. Go to /usr/cognos/cern/bin
2. Type configure. 
3. Type the following, where location/filename.ccs is the configuration that you want to restore:

openfile location/filename.ccs 
4. Type apply. 
5. Type start to start the processes.
6. Type exit. 
Backup and Recovery Guide (Asian Edition)  11
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Back Up and Restore Access Manager Information in UNIX
Security information for Access Manager can be backed up and restored on a Windows computer 
that is communicating with a UNIX directory server. For more information, see "Back Up and 
Restore Access Manager Information in Windows".

Alternatively, you can back up your entire directory server database. For information about using 
an .ldif to backup and restore the directory server, see "Back Up and Restore the Directory Server 
in UNIX". For more information, see the server administration guide for your directory server, or 
the IBM Cognos Series 7 Supplementary Software Installation Guide.

Back Up and Restore the Directory Server Data in UNIX
If you are using a directory server to store Access Manager security information, you can back up, 
and restore, the entire directory server database using an LDAP Data Interchange Format (.ldif) 
file. The .ldif file contains information about the directory server database, as well as information 
specific to Access Manager, such as namespaces. Use the directory server console to export, the 
directory server data into an .ldif file, then import the .ldif to restore the information into a 
directory server.

The following steps indicate how to backup the data for a SunONE directory server.

For more information, see the Sun Web site or your third-party documentation. 

Steps to Back Up
1. Go to the installation_location/usr/directory_server/servers, and type

./startconsole  
2. Log on to the directory server.

For a list of supported versions, see your directory server documentation.
3. In the Console window, expand the server host, and the Server Group folder, and then 

double-click on the directory server used by your existing IBM Cognos Series 7 products.
4. Click the Configuration tab.
5. From the Console menu, click Export
6. In the Export Database dialog, specify a secure location, and the filename for the .ldif, then 

click OK.  

Steps to Restore
1. Go to the installation_location/usr/directory_server/servers, and type

./startconsole  
2. Log on to the directory server Console.

SunONE suggests logging in as Directory Manager (for example, "cn=Directory Manager" 
with default password admin1234).

3. In the Servers and Applications window, expand the server host, then the Server Group folder, 
and then double-click on the new directory server to be used by the new version of IBM 
Cognos Series 7 products.

4. Click the Configuration tab.
5. From the Console menu, click Initialize Databases.  
6. Enter the name of the .ldif you created earlier. 
7. In the Initialize Database column, ensure the check box is selected, and then click OK.  

A message appears, warning you that the operation will overwrite certain information, and 
that certain conditions may affect the success of the initialization. 

8. Click Yes. 
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Back Up and Restore Upfront in UNIX
Upfront is the customizable user interface that you use to view, find, organize and share IBM 
Cognos reports and queries on the Web. You back up and restore the Upfront data store to 
preserve all the information about the resources that Upfront manages, in case any of the 
information is lost or corrupted. 

To either backup or restore the data store, you must run the upfdbadm.exe utility on the computer 
where the data store is installed.

IBM Cognos does not support a "hot" restore of the Upfront data store. This means that before 
you restore the data store, you must stop the Upfront dispatcher. If a hot restore of the Upfront 
data store is performed, errors may occur.

When you back up Upfront, you must back up your security information, and the data stores for 
the IBM Cognos products referenced by NewsItems in this NewsIndex. For more information, see 
"Back Up and Restore Access Manager Information in Windows".

If you change your administrator password and restore the data store at a later time, the data 
store password and the administrator password will not be synchronized. When you start Upfront 
after restoring the data store, Upfront displays an error message indicating that Upfront could not 
log in to the database server. To resolve this problem, change the data store password. For 
information, see the section on administering the data store in the Upfront Server Administration 
Guide. 

In the following steps, specific version numbers for a release are substituted for an italicized letter 
n (n). For example, the cern folder substitutes the rendition number of your IBM Cognos files. The 
rendition number depends on the version you installed, such as cer4 or cer5.

Steps to Back Up
1. Start the processes for Upfront.

Ensure that the data store is started.
2. Go to the /usr/cognos/cern/bin directory.
3. Run UpfDBAdm with the -b parameter. 

For example, type
run-upfdbadm -b ./UpfDatastore.bak  

Steps to Restore
When you restore the Upfront data store you must also restore your security information, and the 
data store for all the IBM Cognos products referenced by NewsItems in this NewsIndex.
1. Start the processes for Upfront.

Ensure that the data store is started.
2. Go to the /usr/cognos/cern/bin directory.
3. Run UpfDBAdmdm with the -r parameter. 

For example, type
run-upfdbadm -r ./UpfDatastore.bak  

4. Go to the /usr/cognos/cern/bin directory.
5. Restart the Upfront processes.

Back Up and Restore PowerPlay Enterprise Server Metadata in UNIX
When using PowerPlay Enterprise Server, you will create a set of directories and files that 
represent your PowerPlay Enterprise Server metadata. To protect your PowerPlay Enterprise 
Server metadata from corruption, you may want to keep backup copies of this information.

If you use Access Manager and Upfront as part of PowerPlay Enterprise Server, then you must also 
back up their metadata. For more information about these topics, see "Back Up and Restore 
Access Manager Information in UNIX", or "Back Up and Restore Upfront in UNIX".
Backup and Recovery Guide (Asian Edition)  13



Back Up and Restore Series 7 Applications  
In the following steps specific version numbers for a release are substituted for an italicized letter n 
(n). For example, the cern folder substitutes the rendition number of your IBM Cognos files. The 
rendition number depends on the version you installed, such as cer4 or cer5.

Steps to Back Up
1. Stop the processes for PowerPlay Enterprise Server.
2. Go to the /usr/cognos/cern/ppserver directory.
3. Copy the PPSRoot.cfx file to the backup location.
4. Copy the PPSRoot directory and its contents to the backup location.

If you are using the Mount At property to store or share metadata across multiple servers you 
must locate that data using the PowerPlay Server Administration tool and copy it to the 
backup location. 

5. Copy any required cubes (.mdc), or report files (.ppx) to the backup location.
Tip: To locate your cube files or your report files, use the PowerPlay Server Administration 
tool and check the Cube Source property.

Steps to Restore
1. Stop the processes for PowerPlay Enterprise Server.
2. Go to the /usr/cognos/cern/ppserver directory.
3. Delete the PPSRoot.cfx file.
4. Delete the PPSRoot directory and its contents.
5. Copy the PPSRoot.cfx backup file to /usr/cognos/cern/ppserver.
6. Copy the backed-up PPSRoot directory and its contents to /usr/cognos/cern/ppserver.
7. Copy the backed-up cubes (.mdc) and reports (.ppx) to the correct folder location.
8. Copy the Mount At directories to the original folder location.
9. Start the processes for PowerPlay Enterprise Server.

Back Up and Restore IBM Cognos NoticeCast in UNIX
The IBM Cognos NoticeCast data store resides in a third-party DB2, Informix, Oracle, or SQL 
server database. Use your database administration tools to back up and restore the IBM Cognos 
NoticeCast data store. When you back up IBM Cognos NoticeCast, you must also back up 
Upfront and Access Manager. For more information about these topics, see "Back Up and Restore 
Access Manager Information in UNIX", or "Back Up and Restore Upfront in UNIX".
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